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1. Summary

This document contains the code artefacts for the implementation of graphical DSLs using a
Model-Driven Approach with Eugenia and EMF/GMF in the Eclipse framework as well as with Epsilon.
The text is to be used as a collection of practical examples to support for the lab lectures of the course
Model-Driven Engineering at Faculdade de Ciéncias e Tecnologia at Universidade Nova de Lisboa

(FCT/UNL) in Portugal.

2. Setup

Note: The detailed descriptions in this and the following sections are using
eclipse-epsilon-1.5-win32-x86_64 downloaded from

https://www.eclipse.org/epsilon/download/


https://www.eclipse.org/epsilon/download/

Creating a Domain Model

Create an Ecore project:

5:. Lab1 - Obeo Designer Community
File Edit Navigate Search Project Run Window Help
New Alt+ShiftsN > 2 Modeling Project
Open File... 'L% Ecore Modeling Project
[ Open Projects from File System... ] Project..
Recent Files > B9 Folder
Close ctl+w  [¥ File
Close A Ctrl+Shift+W U Representations File
Save ctrl+S [ Example..
Save As-, [ Other.. Ctrl+N
Save Al Ctrl+Shift+5 |
Revert
Move
[ Rename.. F2
& Refresh FS
Convert Line Delimiters To >
Print... Ctrl+P
4 Import..
£ Export..
Properties Alt+Enter
Switch Workspace >
Restart
Exit
[Z] Properties

Specify the Ns URI as a universally unique identifier as an absolute URL for this package



2. A Simple Undirected Labelled Graph Case Study

In graph theory, a graph is a set of related objects. The objects are called vertices and each
related pair of vertices is called an edge. We can define graph as an ordered pair G = (V, E)
where V is the set of vertices and E id s set of sets of two vertices.

We can draw a diagram as a schematic (visual) representation of a graph. For instance,
consider the following Graph G={G,V} where the vertices are V={1,2,3,4,5,6} and the
edges are E={{1,2},{1,5},{2,3},{2,5},{3,4},{4,5},{4,6} }. We could represent that example
as:

&

Suppose we want to design the visual editor of diagrams to represent the previous kind of
graphs. We can represent undirected graphs in a diagrammatic form using a Model-Driven
approach with the following general process:
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' Build Abstract Syntax ]

1

Metanhodel Ecare

]
Generate Textual rep resentatinn}

1
et clel Emfatic

1
[ Concrete Syntax Mapping ]

Annotgted Emfatic

Generate Editor with Eugenia

v

Run Second Eclipse Instance

rEdit instance with Graph Editor ’ :

Let’s follow the following steps:

Step 1 - Start Eclipse



©book - Eclipse IDE - o x
File Edit Navigate Search Project Run Window Help

5 & Welcome )

eC|Ip5e Welcome to the Eclipse Modeling Tools

Workbench

Get Started...

Get an overview of the features
A guided walkthrough to the ecore
diagram editor.

Go through tutorials

Create a new Ecore Project to design
your domain model using class

Try out the samples
Review the IDE's most fiercely contested Find out what is new
preferences Always show Welcome at start up.
: :
Step 2 - choose your workbench
©book - Eclipse IDE - a x

File Edit Navigate Search Project Run Window Help
= hd B YO - R ECH i@ il vE v EYD Quick Access

Model Explorer]

type filter text

&% Outline L
An outline is not available.

T Properties

No properties available

J Oitems selected 2

Step 3 - create a new empty EMF project (File->New...->New Empty EMF Project)



£ book - Eclipse IDE - o X
File Edit Navigate Search Project Run Window Help

= HvQ v R T Y@ il vt D v Quick Access| |
2 [Model Explorer] 2 e - F
BS -
type filter text
=2 Graph
&% Outline L

An outline is not available.

I Properties % 2/ Problems

No properties available

1 Graph al

Step 4 - inside the Model folder in the Graph project create an ecore file (File->New...->New
Empty EMF Project)

S book - Eclipse IDE - =] X
File Edit Navigate Search Project Run Window Help
8 £ R0 RAU RSP ST R ETURE TR S CICE v Qu'\ckAccess‘ & [
& Model Explorer & = = (=
B® -
type filter text
v 2 Graph
Esrc
=\ JRE System Library [jre1.8.0_
=\ Plug-in Dependencies
4= META-INF
=mode!
New > [ Project...
Go Into . File
Show In Alt+Shift+w > O Folder
I Copy ctrl+C Representations File
S &5 Copy Qualified Name @& Modeling Project
% Outline 7 [ Paste Ctrl+V 9 Example...
Anoutline is 1 % Delete Delete [ Other.. Ctrl+N
Remove from Context Ctrl+Alt+Shift+Down
Build Path >
Move... °m =08
Rename... F2
23 Import...
4 Export...
& Refresh F5
© Run As >
45 Debug As >
Restore from Local History..
Team >
Compare With >
[9 Emodel  poperties Alt+Enter a

Step S - Right-Click on the Graph.ecore file and select initialize Ecore Diagram



S book - Graph/model/Graph.ecore - Eclipse IDE
File Edit Navigate Search Project Sample Ecore Editor Run Window Help
BrlR@iF -0~ QR iSd i@ i~ Fl~ OOy iBE

& Model Explorer & ~ | & Graph.ecore
E% T > # platform:/resource/Graph/model/Graph.ecore
type filter text
v 2 Graph ey >
> Bsrc Show In Alt+Shift+W >
> BAJRESys  Open F3
> BAPlug-in  Open With >
> EMETA-L [F Copy Ctrl+C
v (zmodel E5 Copy Qualified Name
#]Graj [I3 Paste Ctrl+V
® Delete Delete
Remove from Context Ctrl+Alt+Shift+Down
Mark as Landmark Ctrl+Alt+Shift+Up
< Build Path >
5= Outline Move...
An outline is not Rename.. F2
21 Import...
4 Export...
&1 Refresh F5

4 Generate Emfatic Source
Initialize Ecore Diagram ...
Initialize ecore_diagram diagram file
Map to Ecore...

% Register EPackages

O RunAs >

*» Debug As >

Eugenia >

Epsilon Flock >

. # Graphec 1o 5

Quick Access| : B!

Step 6 - press Next

& Create Representation

Pick an .aird file which will store the diagram, tree, or tables related data.

Enter or select the parent folder:

‘Graph/model

e
v & Graph
=bin
(= META-INF
= model
= src

File name:

Advanced >>

Step 7 - Select Entities in a Class Diagram

Cancel




& Create Representation

Select type of representation

Select the type of representation to create.

£ Entities in a Class Diagram Provides a class diagram to represent EClasses, 2
EClasses in a spreadsheet EDatatypes, EAttributes and their relationships.
EdProperties attributes and categories
B Documentation annotations in a spreadsheet
& Package dependencies diagram

E Droid

E Robot

Step 8 - Press Finish

& Create Representation

Create a new representation

Select the root semantic element for the new representation.

*

Cancel

v &) platform:/resource/Graph/model/Graph.ecore
#

Name of the representation:

class diagram

®

Step 9 - Create the following metamodel

Cancel

10



B Graph

[0.*] edge

[0..%] vertice

——

H Vertice
= Name : EString

= Name : EString

[0.1] x
.11y

Step 10 - Insert an attribute “Name” in the classes (defining the EType as EString)

£ Properties for newAttribute X

newAttribute

Name: @ name

EType: @ EString [java.lang.String] ; [%]
Lower Bound: @ o0

Upper Bound: @ 1

Default Value Literal: @

@ [JTransient

@ [JDerived
Ordered
Unique
Changeable

@ [ Volatile
@ [JUnsettable
® o

@ Cancel oK

Step 11 - Click on the white canvas behind the elements and complete the information in the
properties window

11



] Graph.ecore & *class diagram 2

Br&v[SlR~w =@~ @a100% - |m

H Graph

3
3
o
o
o
0%
g

J ¢
® B B B H [0.*] edge

V.. ] veTuLe

H Vertice

= Name : EString

= Name : EString

[0.1] x
[0.1]y

I Properties %
# graph

Ecore

2

Name:

Documentation graph

Annotation Ns URI:

=)

graph
Rulers & Grid Ns Prefix: @)

graph
Appearance

Semantic

Behaviors

<7

Step 12 - Save the model and right-click on the file to select “Generate Emfatic Source”

12



% Model Explorer o7 B® -

£ class diagram ©
By ~md@~@Q =

type filter text
v i=Graph
@src B Graph
=\ JRE System Library [jre1.8.0_121]
= Plug-in Dependencies

& META-INF
v model
[l Graph.aird
#Graph ~~~-~ [0."] edge

New 0] vertice
Show In Alt+Shift+W >
Open F3 £ Vertice
Open With > = Name : EString

B Copy cul+C 10.11%

&5 Copy Qualified Name 0.1y

(5 Paste Ctrl+V/

X Delete Delete
Remove from Context Ctrl+Alt+Shift+Down
Mark as Landmark Ctrl+Alt+Shift+Up

& Outline 1 Build Path i

Move.
Rename... F2

21 Import.

& Export..

21 Refresh F5

4 Generate Emfatic Source
Initialize Ecore Diagram e
Initialize ecore_diagram diagram file
Map to Ecore,
“% Register EPackages jes available
© RunAs
45 Debug As
Eugenia
Epsilon Flock
Team

Compare With
Replace With
EMF Forms

Properties Alt+Enter
. ) Graph.ecore - Graph/model

You should get the following textual representation of the metamodel:

#] Graph.ecore 2 & class diagram 4 Graph.emf 2

Graph/model/Graph.ecore graph”, prefix="graph")
3

=class Graph {
val Edge[*] edge;
val Vertice[*] vertice;

}

[c RN e NV, IV}

99 class Vertice {
10 attr String Name;

13©class Edge {

14 ref Vertice x;l
15 ref Vertice y;

16 attr String Name;

Step 13 - Complete the model with the following concrete syntax mapping instructions (for more

details about the notations please consult the Eugenia website
https://www.eclipse.org/epsilon/doc/eugenia/ ):

13


https://www.eclipse.org/epsilon/doc/eugenia/

a) The root node (here called Graph as referring, which can be seen as the node that
contains the Graph language elements and relations) should have the following

instruction before:
@gmf.diagram

b) The relation elements that are to be seen as lines in the diagram should be mapped
with:

@gmf.link(source="x", target="y", style="dot", width="2")
c¢) The element to be represented as a box (more formats are possible)
@gmf.node(label = "name"

The result should be similar to:

3mph/modeVGmphecomFraph » prefix="graph")
bl

3

4= @gmt.diagram

5 class Graph {

6 val Edge[*] edge;

7 val Vertice[*] vertice;
8 }

9

10= @gmf.node(label = "Name")
11 class Vertice {

12 attr String Name;

13 }

14

15=@gmf.link(source="x", target="y|', style="dot", width="2")
16 class Edge {

17 ref Vertice x;

18 ref Vertice y;

19 attr String Name;

20 }

21

22

Step 14 - Generate the diagram editor by right-clicking in the Graph.emf file and choose to
generate the gmf editor:



[ TV RSy T e T ~ v Y -

2 Model Explorer 2 5% © 7 Graph.ecore g g # Graph.emf 7
type filter text 1 @namespace(uri="graph", prefix="graph")
) 2 package graph;
v i>Graph 3
2 src 4< @gmf.diagram
=\ JRE System Library [jre1.8.0_121] 5 class Graph {
=\ Plug-in Dependencies 6 val Edge[*] edge;
> META-INF 7 val Vertice[*] vertice;
8}
v =model 9
\T‘Graph.aird 10° @gmf.node(label = "Name")
#1Graph.ecore 11 class Vertice {
iy Graph.er-* o -++-= String Name;
New >
Show In Alt+Shift+W >
Open F3 nk(target.decoration="arrow", style="c
Open With > dge‘(
] ertice x;
B Copy Ctrl+C lertice y;
E= Copy Qualified Name String Name;
[ Paste Ctrl+Vv
% Delete Delete
Remove from Context Ctrl+Alt+Shift+Down
2 Outline 57 Mark as Landmark Ctrl+Alt+Shift+Up
& h Build Path >
v
ggrag h Move...
v
rap . Rename... F2
= gmf.diac N
=edge : B Import...
Y
=vertice: Expore
v [ Vertice & Refresh F5
v @mgmf.nod f# Generate Ecore Model
label O Run As >
= Name : ¢ ¥ Debug As 4
v HEdge Eugenia > ¢l Generate GMF editor
v Bagmflink Epsilon Flock > #] Generate Ecore model
targe  Team > [E Generate EMF editor
style Compare With >
=X : Vertic Replace With >
=y:iVertic  properties Alt+Enter

= Name : String

Step 15 - Right-Click in the Graph.emf file and choose “Run as”->"Run Configurations” and
choose to run as “Eclipse Application”

Step 16 - A second instance of Eclipse will run
Step 17 - Create a General Project.

Step 18 - Create inside the Project the file you want to edit File->Create->Other (look for
Examples and there you should find “Graph Diagram”)



£ runtime-New_configuration - teste/default.graph_diagram - Eclipse Platform

File Edit Diagram Navigate Search Project Run Window Help
N-HRB~icsy v @ikl il vt v
“Segoe Ul vl vIBI|A~

v v o v |Bivoviny |

{5 Project Explorer ==

o

[0 *default.graph_diagram
=teste

+ V1
+ V2

8z Outline & [ Task List
e EE -

¥ Tasks & Properties

0 items

~ ]

Description

Save the model
Right-click on the canvas and select Generate->All

On the left side you will see new packages being generated:

< H ~ | 100%

v
Quick Access|: B |l
=0

.* Palette >

heaaD-

= Objects @
+ Vertice

= Connections

+ Edge

Resource Path

16




File Edit Diagram Mavigate Search Project Run Wind:
N LRt O~ Qi il bl
B Model Explorer 2 2% v =09 &s *labl
type filter text | "2 -%
A EJ my.first model lab1
B\ Project Dependencies
> [ sre-gen
> Bsre
> B\ JRE System Library [jre18.0_121]
> B Plug-in Dependencies
* = META-INF
» [ model
b build properties
|l plugin.properties
& pluginsxml
> & my.first.model.labl.edit
> & my first.model.lab.editor

0= Qutline 2 BEE - O
L B " g
— |‘— o )
I S L
X -
Edit
4" Refresh
I0.] edge Unsynchronized
(@ Export diagram as image
& Show/Hide
Y Select
0% Layout
——Y—————  Reset Origin Ctri+|
—] H Edge _ _
———————  Validate diagram
£ name : EStning
_— Find Ctrl+Alt+5
Quick search (
s Show EClass information
= Show References
oAl | Generate
B2 Model Code |4 Add Related Elements
B Edit Code Open User Guide
B2 Editor Code . l=> Package

17



To test the metamodel we can launch a simple editor, by selecting runtime configurations:

File Edit Diagram Mavigate Search Project Run Wi
ﬂv[{[ﬁ#vﬂv‘;qu_r
{no launch history)

Run As b

Run Configurations...

- Model Explorer |
type filter text

v i myfirstmodel. Organize Favorites...
B Project Dependencies 1
> [® sre-gen
> (B sre
* B\ JRE System Library [jre1.8.0_121]
» B\ Plug-in Dependencies
* = META-INF
* = model
b build.properties
|7| pluginproperties
&} plugin.xml
» 5 my first.model.lab1.edit
> e my first model.lab1.editor

B ot =8

Select “Eclipse Application” for a new configuration:

18



i:' Run Cenfigurations

Create, manage, and run configurations

Create a configuration to launch an Eclipse application.

MILELIER SR A
type filter text

B Acceleo Application

v & Eclipse Application
& New_configuration

¥ Java Applet

[T Java Application

Ju JUnit

Jt JUnit Plug-in Test

@ Launch Group

@ 05Gi Framework

& SWTBot Recorder Server

& SWTBot Test

& Test Recorder

And you can rename at will (for instance to “test” instead of “New_Configuration”).

Marme: :New_cnnrigurar.inn
El Main (9= Arguments =
Waorkspace Data
ocation: ${workspace_loc)/./
[C]Clear: workspace loxt

Ask for confirmation before
Program to Run
(®) Run a product: frobe
() Run an application: org.ecl
Java Runtime Environment

Java executable: (O

@ Execution environment: Ja

() Runtime JRE: jre

A second instance of Eclipse should run.

Create a new modelling project

19



'I'-:. runtirme-Mew_configuration - Obeo Designer Community

File Edit Mavigate 5Search Project Run  Window Help

Mew Alt+Shift«N > 22  Modeling Project
Open File... Iqh'! Ecore Modeling Project
[y Open Projects from File System... ™ Project...
Recent Files -] % Folder
Close Ctel+W | [ File
Close All Ctrl+Shift+W Representations File
Save Ctr+S [ Example...
Save fs... rﬁ Other... Chrl+M
Save All Ctrl+Shift+5
Revert
Move...
Rename... F2
& ] Refresh F5
Convert Line Delimiters To -]

Give it a name, for instance lab1



File Edit Mavigate Search Project Run  Window Help
Dl it O Qi il Al G

by runtime-Mew_configuration - lab1/representations.aird - Obeo Designer Community

[Quckrcee] | g2 |
(]

*

B Model Explorer 21 = 8 lab1 22 =
Bov . . Fy
= lab1/representations.aird
|t_|,rpe filter text |
5 2 labl Models s Representations
| type filter text |t)fpe filter text | E
=i, Project Dependencies Ret
Remaove En
Dig
EE QOutline 532 = 8
There is no active editor that provides an Group representations by viewpoint v
outline, < >
Overview
[ Properties &1 % Problems ¥ = 8

MNe properties available

right -click on lab1 and select new->other and write lab, you will see this:

21



wr New

Select a wizard

d >

—_—

This will create a plugin with all necessary code for a right-click action labelled J_
“Acceleo » Launch” on candidate models.

=l

Wizards:

' lab

s = Acceleo Model to Text

@ Lab1 Model

[2 Acceleo Ul Launcher Project
w [ Example EMF Model Creation Wizards

® < Back

Select lab 1 Model

Finish

22



ar New

Lab1 Model

Create a new Lab1 model

¥

Enter or select the parent folder:

| lab1

HREl=
=2 1ab1

File name: | My lak

@ <Back [ Next>

Change the name, if you prefer, and click next

Finish

23



Select Graph as Model Object (model root element)
#4. Mew
Lab1 Model

O
Select a model object to create ¢’

Madel Object

Edge

Wertice

EHr=o

@ < Back Next > Finish Cancel

You will see the following:



o runtime-New_configuration - lab1/My.lab1 - Obeo Designer Community
File

Edit Mavigate Search Project Labl Editer Run  Window Help
h - M#vev%vq‘;v’%}_v > to oo -
- Model Explorer 53 = 8 5] *lab1 [ My.labl &2
B o i My
= G=|'=> ~ r[\j Resource Set
|typefi|tertext | W @ platform:/resource/lab1/My.lab1
v 2 13k ¢ Graph
=, Project Dependencies
1 My lab1
representations.aird
o= Outline i3 = B8

@ platform:/resource/lab1/My.lab1

Selection | Parent | List| Tree | Table | Tree with Columns

[ Properties &3

Property Value

You can now add elements to the model in the right side:

B Model Explorer 52

= O ab’

&l My.lab1 &3
S =

|tg,rp e filter text

rﬁ_ﬁ Resource 5et

v (27 lab1
B Project Dependencies
v (B My.lab
w <4 Graph
4 Edge ed
4 Vertice =1
4 Vertice =2
representaticns.aird

The tool will only allow you to insert instances that are valid according to the metamodel.

v 4 platform:/resource/labl1/My.lab1
w < Graph

< Edge ed
4 Vertice =1
4 Vertice s2

25



In case you want to customize the icons, you can change them just by going back to the first

instance of eclipse and in the edit package look for the icons folder:

File Edit Diagram Mavigate Search Project Rur
He it O Qeigvil
% Model Explorer 0% v

type filter text o

pip build.properties -
| plugin.properties
& pluginxml
v [ my first model.lab1.edit
[ sre-gen
B\ JRE System Library [JavaSE-1
B Plug-in Dependencies

¥ [=ricons
v (= full
v [ 0bj16

& Edge.gif
@ Graph.gif
P Vertice.gif

(= META-INF v

9% Qutline Y =

Select the icons you want to overwrite (should have the same names) and copy them there.

To preview, select in the metamodel on the right the following “Icons Preview” option on the
ecore tools:

26



& lab1 |

DDD':EIE:' & :,.7 (s v EE
» Package
Documentation
" \alidation
Constraint Graph .
Related EClasses .l eage

I lcons Preview

v &S % - 6

H vertice r ¥

E Edge
= name ; EString [0.1] =

= name : EStning

0.1 ¥

And there it goes:

[0..*] edge
[4..*] vertice
' L
& Vertice ; _
(=)l Edge
= name : EStning 0.7 x @

= name : EString

0.1y

So that the simple ecore editor is also updated we have to save this model and regenerate All

If we restart the workplace in the second eclipse instance, we will update the editor as well.

27



File Edit Mavigate Search Project LablEditer Run  Window Help
NrE@ieit- O Qrif i~ o oo
B =] lab1 il My.lab1 23

R

I

B Maodel Explorer 53

|
14

L™ Resource Set

|t_-,rpeﬁ|tertext w & platform:/resource/lab1/My.lab1
! labt v U Graph
Edge ed
s Vertice 51
s~ Vertice s2

3. Turing Machines graphical language

The Turing machine was invented in 1936 by Alan Turing and is a mathematical model of
computation of an abstract machine that operates on an unlimited tape (extending infinitely in
one direction) according to programmed control logic. Can be seen as a finite-state machine in
which a transition prints a symbol on the tape. The head of the tape may move to either left or

right, allowing the machine to manipulate by reading and writing at will.
It can be defined as a 6-tuple M={ Q, 3, I, 9, q0, F }, where:

- Qs a finite set of states,

- Tis afinite set called the tape alphabet with a special symbol B that represents a blank

cell in the tape,
- Y is asubset of I except B,

- 9 is the transition function (a partial function from Q x I to Q x I x {L,R}),

- g0 € Qis the initial/start state,
- FC< Qs a set of final states.

The transition function of a standard Turing machine with the input alphabet '={a,b} U {B} and
the states Q = {s0,s1,s2,s3 }, where q0 = s0 and F = { s3 } with the program to accept strings
with the following regular expression (a+b)*aa can be described as follows:

28



>|se |[s1, B, R

sl Sl) a, R 52, a, R
s2 53) b: R Sl: b) R
*¥ [s3

(* identifies a final state, while > tags the start state)

Consider the following visual notation to describe Turing machines

Control Logic

The transition function can be graphically represented by a state diagram:

~—~ BB,R ~—~ aa,R — a/aR
» S0 ) >(s1 )4 "(s2) @
~4 bb,R —

b/b, R

Now, following the same process as the section before, we have:

Bl Bl Bl ® ® ® |yfinite Tape

29



N

[ Build Abstract Syntax ]

1

Metamodel Ecore

]
[Generate Textual rep resentatinn}

l
Metamnpdel Emfatic

!
Concrete Syntax Mapping

Annotgted Emfatic
[1]

Generate Editor with Eugenia

A d
Run Second Eclipse Instance

3
Edit instance with Graph Editor

Please follow the steps used to create the Graph editor for the Graph language. The
metamodel in ecore can be the following.

30



2 Movement
[0- 1] out H state
= Left
= Right = Name : EString
[0.1]in
B Transition [0..*] hasStates

= Move : Movement = Left
= Read : EString
= Write : EString

[0..*] hasTransitions B mr

After generating the emfatic file with the textual representation of the metamodel, you can
annotate (syntax mapping) in the following way:

@namespace(uri="http://myturing/1.0", prefix="myturing")
package myturing;

@gmf.diagram(foo="bar")
class MT {
val State[*] hasStates;
val Transition[*] hasTransitions;

}

@gmf.node(label = "Name", tool.name= "State")
class State {
attr String Name;

}

@gmf.link(source="in", target="out", label="Move, Read, Write",
label.pattern="{0},{1},{2}",source.decoration="filledsquare™")
class Transition {

attr Movement Move;

attr String Read;

attr String Write;

ref State in;

ref State out;

}

enum Movement {
Left = 0;

31




Right = 1;

After generating the editor and running the second instance of Eclipse, you can build an

instance model like the one in the following example:

#] TM.ecore

= Properties © (2! Proble
¢+ Undefined
Core Property

Rulers & Grid

Appearance

& myturing class diagram 3 TM.emf

Right,B.X

4 TuringMachine

i) *default. myturing_diagram ©*

Value

Right,B.X

+s3

i* Palette
RQQD-
(= Objects
¥ State
(= Connections

¥ Transition

32




4. The Traffic Lights Control language - Different
target technology platforms

Traffic-lights are a common device of our daily life. We pass by them unaware that their
behaviour varies more widely than we might expect. Different countries have different rules,
equipment and standards (have a glimpse at this variety for instance in
https://en.wikipedia.ora/wiki/Traffic_light). We will next design a naive language for describing
the behavior of a traffic-light like the one in the figure above. In the process we will introduce the
notion of well-formed instance models and how to specify well formedness rules using EVL. We
will also show how to generate code from our models to two different target technologies: an
arduino controller and a simulator implemented in Java.

4.1. The control language editor and examples of
well-formedness rules using EVL

The emfatic code for the editor:

@namespace(uri="http://trafficlight/1.0", prefix="trafficlight")
package trafficlight;

@gmf.diagram
class Traffic {
val Green hasGreen;
val Red hasRed;
val Yellow hasYellow;
val Black hasBlack;
val Off[*] hasOff;
val On[*] hasOn;
val Police[*] hasPolice;
val Next[*] hasNext;

}

abstract class Light {

33
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attr String name;
attr boolean IsStart;

}

@gmf.node(label="name", color="255,255,0", figure="ellipse")
class Yellow extends Light {

}

@gmf.node(label="name", color="0,255,0", figure="ellipse")
class Green extends Light {

}

@gmf.node(label="name", color="255,0,0", figure="ellipse")
class Red extends Light {
}

@gmf.node(label="name", color="0,0,0", figure="ellipse")
class Black extends Light {
}

class Change {
ref Light hasInputlLightState;
ref Light hasOutputLightState;
attr String name;

}

@gmf.link(source="hasInputLightState"”, target="hasOutputLightState", style="dot",
width="1", target.decoration="arrow", source.decoration="filledrhomb")
class On extends Change {

Example of Eclipse Validation Language (EVL) rules:

context Light {
constraint AtLeastTwo {
check: Light.allInstances.size() >=2

message : 'There should be at least two lights'

}

Example of an instance model:
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Below we can find an example of an egl code to generate Java code of a simulator of the traffic

light control.

import java.awt.*;

import javax.swing.*;

import java.awt.event.*;
import javax.swing.border.*;

public class TrafficLight extends JFrame implements ActionListener {
JButton bon, boff, bpolice, bnext;

public static final int BLACK
public static final int GREEN
public static final int YELLOW
public static final int RED

. e

. e

I
W N
-

)

Signal green = new Signal(Color.green);
Signal yellow = new Signal(Color.yellow);
Signal red = new Signal(Color.red);

Integer presentState=BLACK;

public TrafficLight(){
super("Traffic Light");
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getContentPane().setLayout(new GridLayout(2, 1));

bon = new JButton("On");

boff = new JButton("Off");
bpolice = new JButton("Police");
bnext = new JButton("Next");

bon.addActionListener(this);
boff.addActionListener(this);
bpolice.addActionListener(this);
bnext.addActionListener(this);

green.turnOn(false);
yellow.turnOn(false);
red.turnOn(false);

JPanel pl = new JPanel(new GridLayout(3,1));
pl.add(red);

pl.add(yellow);

pl.add(green);

JPanel p2 = new JPanel(new FlowlLayout());
p2.add(bon);

p2.add(boff);

p2.add(bpolice);

p2.add(bnext);

getContentPane().add(pl);
getContentPane().add(p2);
pack();

}

public static void main(String[] args){

}

TrafficLight t1 = new TrafficlLight();
tl.setVisible(true);

public void turnblack(){

}

green.turnOn(false);
yellow.turnOn(false);
red.turnOn(false);
presentState=BLACK;

public void turngreen(){

}

green.turnOn(true);
yellow.turnOn(false);
red.turnOn(false);
presentState=GREEN;

public void turnyellow(){

green.turnOn(false);
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yellow.turnOn(true);
red.turnOn(false);
presentState=YELLOW;

}

public void turnred(){
green.turnOn(false);
yellow.turnOn(false);
red.turnOn(true);
presentState=RED;

public void actionPerformed(ActionEvent e){
if (e.getSource() == bon){
switch(presentState){

[% for (o in On.all) {%]
case [%=o0.hasInputLightState.type.name.toUpperCase()%]:
turn[%=0.hasOutputLightState.type.name.tolLowerCase()%](); break;
[%}%]
default: break;
}

} else if (e.getSource() == boff){

switch(presentState){

[% for (o in Off.all) {%]
case [%=o0.hasInputLightState.type.name.toUpperCase()%]:
turn[%=0.hasOutputLightState.type.name.toLowerCase()%](); break;
[%}%]
default: break;
}

} else if (e.getSource() == bpolice){
switch(presentState){
[% for (p in Police.all) {%]
case [%=p.hasInputLightState.type.name.toUpperCase()%]:
turn[%=p.hasOutputLightState.type.name.toLowerCase()%](); break;
[%}%]
default: break;
}

} else if (e.getSource() == bnext){
switch(presentState){
[% for (n in Next.all) {%]
case [%=n.hasInputLightState.type.name.toUpperCase()%]:
turn[%=n.hasOutputLightState.type.name.toLowerCase()%](); break;
[%}%]
default: break;
}
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class Signal extends JPanel{

Color on;

int radius = 490;
int border = 10;
boolean change;

Signal(Color color){
on = color;
change = true;

}

public void turnOn(boolean a){
change = a;
repaint();

}

public Dimension getPreferredSize(){
int size = (radius+border)*2;
return new Dimension( size, size );

}

public void paintComponent(Graphics g){
g.setColor( Color.black );
g.fillRect(0,0,getWidth(),getHeight());

if (change){

g.setColor( on );
} else {

g.setColor( on.darker().darker().darker() );
}

g.filloval( border,border,2*radius,2*radius );
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On Off Police Next

4.2. Model-to-Text - generating to Arduino as target platform

Suppose we have an arduino implementation of the traffic-lights controller with the following
hardware setup:
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Below we can find an example of an egl code to generate the controller for an arduino setup of
the traffic light control.

const
const
const
const

const
const
const

int
int
int
int
int
int
int

int next=0;
int onoff=0;
int police=0;

BLACK
GREEN
YELLOW
RED =

. we

1}
W NEFEOo
-

e

e

EONOFF = 1;
EPOLICE = 2;
ENEXT = 3;

int presentState=BLACK;
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void currentState() {
switch(presentState){

case BLACK: black(); break;
case GREEN: green(); break;
case YELLOW: yellow(); break;
case RED: red(); break;

default: break;

}
}

void black(){
digitalWrite(11,LO0W);
digitalWrite(12,LO0W);
digitalWrite(13,LO0W);
}

void green(){
digitalWrite(11,HIGH);
digitalWrite(12,LO0W);
digitalWrite(13,LO0W);
}

void yellow(){
digitalWrite(11,LO0W);
digitalWrite(12,HIGH);
digitalWrite(13,LO0W);
}

void red(){
digitalWrite(11,LO0W);
digitalWrite(12,LO0W);
digitalWrite(13,HIGH);
}

void turnblack(){
presentState=BLACK;

}

void turngreen(){
presentState=GREEN;

}

void turnyellow(){
presentState=YELLOW;

}

void turnred(){
presentState=RED;
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}

void actionPerformed(int e){
if (e==EONOFF){

switch(presentState){
[% for (o in On.all) {%]
case [%=o0.hasInputLightState.type.name.toUpperCase()%]:
turn[%=0.hasOutputLightState.type.name.toLowerCase()%](); break;
[%}%]
[% for (o in Off.all) {%]
case [%=o0.hasInputLightState.type.name.toUpperCase()%]:
turn[%=0.hasOutputLightState.type.name.toLowerCase()%](); break;
[%}%]
default: break;

}s

} else if (e == EPOLICE){

switch(presentState){
[% for (p in Police.all) {%]

case [%=p.hasInputLightState.type.name.toUpperCase()%]:
turn[%=p.hasOutputLightState.type.name.toLowerCase()%](); break;
[%}%]
default: break;
}

} else if (e == ENEXT){
switch(presentState){

[% for (n in Next.all) {%]
case [%=n.hasInputLightState.type.name.toUpperCase()%]:
turn[%=n.hasOutputLightState.type.name.toLowerCase()%](); break;
[%}%]
default: break;

}
}s
delay(250);

void setup() {
// put your setup code here, to run once:

pinMode (13, OUTPUT);

pinMode(12, OUTPUT);

pinMode (11, OUTPUT);

pinMode(4, INPUT);

pinMode(3, INPUT);

pinMode(2, INPUT);

}

void loop() {
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next=digitalRead(2);
police=digitalRead(3);
onoff=digitalRead(4);

int tmp=0;

if (onoff==HIGH) tmp=EONOFF;

else if (police==HIGH) tmp=EPOLICE;
else if (next==HIGH) tmp=ENEXT;

if(tmp>0) actionPerformed(tmp);
currentState();

The output TraffiLight.java file will be:

import java.awt.”;
import javax.swing.*;
import java.awt.event.”;

import javax.swing.border.*;

JButton bon, boff, bpolice, bnext;

public static final int BLACK = 0;
public static final int GREEN = 1;
public static final int YELLOW = 2;
public static final int RED = 3;

Signal green = new Signal(Color.green);
Signal yellow = new Signal(Color.yellow);
Signal red = new Signal(Color.red);

Integer presentState=BLACK;

public TrafficLight(){
super("Traffic Light");

public class TrafficLight extends JFrame implements ActionListener {
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getContentPane().setLayout(new GridLayout(2, 1));

bon = new JButton("On");

boff = new JButton("Off");
bpolice = new JButton("Police");
bnext = new JButton("Next");

bon.addActionListener(this);
boff.addActionListener(this);
bpolice.addActionListener(this);
bnext.addActionListener(this);

green.turnOn(false);
yellow.turnOn(false);
red.turnOn(false);

JPanel p1 = new JPanel(new GridLayout(3,1));
p1.add(red);

p1.add(yellow);

p1.add(green);

JPanel p2 = new JPanel(new FlowLayout());
p2.add(bon);

p2.add(boff);

p2.add(bpolice);

p2.add(bnext);

o~~~ o~

getContentPane().add(p1);
getContentPane().add(p2);
pack();

}

public static void main(String[] args){
TrafficLight tl = new TrafficLight();
tl.setVisible(true);

}

public void turnblack(){
green.turnOn(false);
yellow.turnOn(false);
red.turnOn(false);
presentState=BLACK;

}

public void turngreen(){
green.turnOn(true);
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yellow.turnOn(false);
red.turnOn(false);
presentState=GREEN;
}
public void turnyellow(){
green.turnOn(false);
yellow.turnOn(true);
red.turnOn(false);
presentState=YELLOW;
}
public void turnred(){
green.turnOn(false);
yellow.turnOn(false);
red.turnOn(true);
presentState=RED;

}

public void actionPerformed(ActionEvent e ){
if (e.getSource() == bon){

switch(presentState){

default: break;

}

} else if (e.getSource() == boff){
switch(presentState){

default: break;

}

} else if (e.getSource() == bpolice {
switch(presentState){

default: break;

}

} else if (e.getSource() == bnext){
switch(presentState){
case BLACK: turnred(); break;
case RED: turnyellow(); break;
case YELLOW: turngreen(); break;
case GREEN: turnred(); break;




default: break;

}
}
}

class Signal extends JPanel{

Color on;

int radius = 40;
int border = 10;
boolean change;

Signal(Color color)¥
on = color;
change = true;

}

public void turnOn(boolean a){
change = a;
repaint();

}

public Dimension getPreferredSize(){
int size = (radius+border)*2;
return new Dimension( size, size );

}

public void paintComponent(Graphics g){
g.setColor( Color.black );
g.fillRect(0,0,getWidth(),getHeight());

if (change){

g.setColor( on );
}else {

g.setColor( on.darker().darker().darker() );
}

g.fillOval( border,border,2*radius,2*radius );
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5. The Feature Models Language

Arrange All | l

H Link

—_—

= Feature

= name : EString

= name : EString

[0.1] father

H Optional H Mandatory

[0..1] san

= isRoot : EBooleanOhject

[0.%] link

[0..1] source

[0.1] target

[0..1] $ource

JR——
E FeatureToAggregationLin

= name : EString

[0..1] target

[0..*] feature:

* | FeatureModel

H Dependencylink

= name : EString

[0..*] dependencylink r

[0..*] featAggro = name ; Estring

i Or

E Alternative

[0..*] aggregation

™5 Aggregation

= name : EString

B AggregationToFeatureLinl

= name : EString
[0..1] target

[0..°] aggroFeat

= Excludes

= Requires

[0..1] soyrce

Next, we can see a short implementation of a feature models editor without much concerns related to the
usability (naive and simplistic concrete syntax):

@gmf.diagram

class FeatureModel {
attr String name;
val Link[*] link;

}

class Feature {
attr String name;

val Feature[*] features;

val Aggregation[*] aggregation;
val FeatureToAggregationLink[*] featAggro;
val AggregationToFeatureLink[*] aggroFeat;
val DependencyLink[*] dependencylink;

@gmf.node(label="name"

attr Boolean isRoot;

@namespace(uri="FeatureDiagram", prefix="FeatureDiagram")
package FeatureDiagram;
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}

abstract class Link {
attr String name;
ref Feature father;
ref Feature son;

}

@gmf.link(source="father", target="son", target.decoration="filledrhomb")
class Mandatory extends Link {

}

@gmf.link(source="father", target="son", target.decoration="rhomb")
class Optional extends Link {

}

abstract class Aggregation {
attr String name;

}

@gmf.node(label="name"
class Alternative extends Aggregation {

}

@gmf.node(label="name"
class Or extends Aggregation {

}

@gmf.link(source="source", target="target")
class FeatureToAggregationLink{

attr String name;

ref Feature source;

ref Aggregation target;
}

@gmf.link(source="source", target="target")
class AggregationToFeatureLink{

attr String name;

ref Aggregation source;

ref Feature target;

}

abstract class DependencylLink {
attr String name;
ref Feature source;
ref Feature target;

}

@gmf.link(source="source", target="target", source.decoration="arrow", target.decoration="arrow",
style="dash")
class Excludes extends DependencylLink {

}

@gmf.link(source="source", target="target", target.decoration="arrow", style="dash")
class Requires extends DependencylLink {

}

A snapshot of the editor looks like (an example of usability problems related to the chosen concrete
syntax):
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The corresponding validation rules are:
context FeatureModel{
constraint mustHaveName {
check: self.name <> "'
message: 'A Feature Diagram must have a name’
fix {
title: 'Insert ' + self.eClass().name + ' Name'
do {
var name := UserInput.prompt('Insert ' + self.eClass().name + ' Name',
")
self.name = name;
}
¥

}

context Feature {
constraint noFatherOfSelf{
check: Link.allInstances.select(l | 1l.father.name = 1l.son.name and self.name =

l.son.name).size() = ©

message: 'Features cant be father of themselves'

}

constraint noNameRepetions {
check: Feature.allInstances.excluding(self)->forAll(i | i.name <> self.name)

message: 'Two Features cant have the same name'’

}

constraint noRootFeatures {
guard: Feature.allInstances.select(f | f.isRoot = true).size() = @




check {
return Feature.allInstances.select(f | f.isRoot = true).size() <> 0;

}

message: 'There are no Root Features. This can be fixed by Quick Fix"'

fix {
title: 'Root ' + self.eClass().name + ' is needed’

do {
var rootFeatureSequence = Feature.allInstances.select(f |

Link.allInstances.forAll(1l | l.son.name <> f.name)
and AggregationToFeaturelLink.allInstances.forAll(1 |

l.target.name <> f.name));

if(rootFeatureSequence.size() > 1) {
rootFeatureSequence.size().println('Size do If: ');
var sonFeature := UserInput.choose('Select feature',

_Model.getAl10fType(self.eClass().name));

sonFeature.isRoot = true;
} else {
rootFeatureSequence[@].isRoot = true;

}

}

constraint onlyOneRootFeature {
guard: Feature.allInstances.select(f | f.isRoot = true).size() > @

check: Feature.allInstances.select(f | f.isRoot = true).size() = 1 or not (self.isRoot

= true)
message: 'There can only be one Root Feature'

}

constraint nonRootFeatureMustHaveAFather {
check: Link.allInstances.select(l | 1l.son.name = self.name).size() +
AggregationToFeatureLink.allInstances.select(l | l.target.name = self.name).size() = 1 or self.isRoot =

true

message: 'Non-Root Features can only have one father feature’

}
context Aggregation {
constraint atLeastTwoFeatures{
check: AggregationToFeaturelLink.allInstances.select(l | l.source = self).size() > 1

message: 'Aggregation Nodes must have at least two child Features'

¥
context Link {
constraint notFatherOfRoot {
check: self.son.isRoot <> true

message: 'The Root Feature cant have fathers'

}

//Excludes
operation DependencylLink noExcludesMandatories() : Boolean {
var excludesSourcelLinks = Link.allInstances.select(l | l.son.name = self.source.name)[0];
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var excludesTargetLinks = Link.allInstances.select(l | l.son.name = self.target.name)[0];
return excludesSourcelLinks.eClass().name <> 'Mandatory’' and excludesSourcelLinks.eClass().name
<> 'Mandatory’
or excludesSourcelLinks.father.name <> excludesTargetLinks.father.name;

}

operation DependencylLink noExcludesAlternative() : Boolean {

var excludesSourcelinks = AggregationToFeaturelLink.allInstances.select(l | 1l.target.name
self.source.name)[0];

var excludesTargetLinks = AggregationToFeaturelLink.allInstances.select(l | 1l.target.name
self.target.name)[0];

return excludesSourcelLinks.source.name <> excludesTargetlLinks.source.name or
excludesSourcelLinks.source.eClass().name <> 'Alternative’;

}

operation DependencylLink noExcludesBetweenMandatoryAndAlternative() : Boolean {

var excludesSourcelLinks = Link.allInstances.select(l | l.son.name = self.source.name)[0];

var excludesTargetLinks = AggregationToFeaturelLink.allInstances.select(l | l.target.name =
self.target.name)[0];

return excludesSourcelLinks.eClass().name <> 'Mandatory' or
excludesTargetLinks.source.eClass().name <> 'Alternative’;

}

operation DependencylLink noExcludesBetweenAlternativeAndMandatory() : Boolean {

var excludesSourcelLinks = AggregationToFeaturelLink.allInstances.select(l | 1.target.name
self.source.name)[0];

var excludesTargetlLinks = Link.allInstances.select(l | l.son.name = self.target.name)[0];

return excludesSourcelLinks.source.eClass().name <> 'Alternative' or
excludesTargetLinks.eClass().name <> 'Mandatory';

}

operation DependencylLink noExcludesBetweenMandatoryAndOr() : Boolean {

var excludesSourcelLinks = Link.allInstances.select(l | l.son.name = self.source.name)[0];

var excludesTargetLinks = AggregationToFeaturelLink.allInstances.select(l | 1l.target.name =
self.target.name)[0];

return excludesSourcelLinks.eClass().name <> 'Mandatory' or
excludesTargetLinks.source.eClass().name <> 'Or'

or AggregationToFeaturelink.allInstances.select(l | 1.source =

excludesTargetLinks.source).size() > 2;

}

operation DependencylLink noExcludesBetweenOrAndMandatory() : Boolean {

var excludesSourcelLinks = AggregationToFeaturelLink.allInstances.select(l | 1l.target.name =
self.source.name)[0];

var excludesTargetlLinks = Link.allInstances.select(l | l.son.name = self.target.name)[0];

return excludesSourcelLinks.source.eClass().name <> 'Or' or excludesTargetLinks.eClass().name
'Mandatory’

or AggregationToFeaturelLink.allInstances.select(l | l.source =

excludesSourcelLinks.source).size() > 2;

}

//Requires
operation DependencyLink noRequiresMandatory() : Boolean {
var requiresSourcelLinks = Link.allInstances.select(l | l.son.name = self.source.name)[0];
var requiresTargetLinks = Link.allInstances.select(l | l.son.name = self.target.name)[0];
return requiresTargetlLinks.eClass().name <> 'Mandatory' or requiresSourcelLinks.father.name <>
requiresTargetLinks.father.name;

}

operation DependencylLink noRequiresAlternative() : Boolean {

var requiresSourcelinks = AggregationToFeaturelLink.allInstances.select(l | 1l.target.name =
self.source.name)[0];

var requiresTargetLinks = AggregationToFeaturelLink.allInstances.select(l | 1l.target.name =
self.target.name)[0];

return requiresSourcelLinks.source <> requiresTargetlLinks.source or

<>
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requiresSourcelLinks.source.eClass().name <> 'Alternative’;

}

operation DependencylLink noRequiresBetweenMandatoryAndAlternative() : Boolean {

var requiresSourcelinks = Link.allInstances.select(l | l.son.name = self.source.name)[0];

var requiresTargetlLinks = AggregationToFeaturelLink.allInstances.select(l | 1l.target.name =
self.target.name)[0];

return requiresSourcelLinks.eClass().name <> 'Mandatory’ or
requiresTargetLinks.source.eClass().name <> 'Alternative’;

}

operation DependencylLink noRequiresBetweenMandatoryAndOptionalAlternative() : Boolean {

var requiresSourcelinks = Link.allInstances.select(l | l.son.name = self.source.name)[0];

var requiresTargetlLinks = AggregationToFeaturelLink.allInstances.select(l | 1l.target.name =
self.target.name)[0];

var featureToAggregation = FeatureToAggregationLink.allInstances.select(l | 1.target =
requiresTargetLinks.source)[0];

var featureLink = Link.allInstances.select(l | 1l.son.name =
featureToAggregation.source.name)[0];

return requiresSourcelLinks.eClass().name <> 'Mandatory' or
requiresTargetLinks.source.eClass().name <> 'Alternative’

or featureLink.eClass().name <> 'Optional’;

}

operation DependencylLink noRequiresBetweenMandatoryAndOr() : Boolean {

var requiresSourcelinks = Link.allInstances.select(l | l.son.name = self.source.name)[0];

var requiresTargetLinks = AggregationToFeaturelLink.allInstances.select(l | 1l.target.name =
self.target.name)[0];

return requiresSourcelLinks.eClass().name <> 'Mandatory’ or
requiresTargetLinks.source.eClass().name <> 'Or';

}

operation DependencyLink noRequiresMandatoryAndOptional() : Boolean {
var requiresSourcelinks = Link.allInstances.select(l | l.son.name = self.source.name)[0];
var requiresTargetlLinks = Link.allInstances.select(l | l.son.name = self.target.name)[0];

return requiresSourcelLinks.eClass().name <> 'Mandatory' or requiresTargetlLinks.eClass().name <>

'Optional’
or requiresSourcelLinks.father.name <> requiresTargetLinks.father.name;

}

context Excludes {
constraint noExcludesBetweenMandatoryAndOpcional {
guard: Link.allInstances.select(l | l.son.name = self.source.name).size() > @
and Link.allInstances.select(l | 1l.son.name = self.target.name).size() > @
check: self.noExcludesMandatories()

message: 'Mandatory features cant be the source or target of an Excludes dependency
with other feature that shares the same father'

}

constraint noExcludesAndAlternative {
guard: AggregationToFeaturelLink.allInstances.select(l | l.target.name =
self.source.name).size() > ©
and AggregationToFeaturelLink.allInstances.select(l | 1l.target.name =
self.target.name).size() > ©
check: self.noExcludesAlternative()

message: 'This Excludes Dependency is Redundant'’

}

constraint noExcludesBetweenMandatoryAndAlternative {
guard: Link.allInstances.select(l | 1l.son.name = self.source.name).size() > @
and AggregationToFeaturelLink.allInstances.select(l | l.target.name =
self.target.name).size() > ©
check: self.noExcludesBetweenMandatoryAndAlternative()
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message:

}

'The feature ' + self.target.name + ' is a Dead Feature'’

constraint noExcludesBetweenAlternativeAndMandatory{
guard: AggregationToFeaturelLink.allInstances.select(l | 1l.target.name =

self.source.name).size()

> 0
and Link.allInstances.select(l | l.son.name = self.target.name).size() > ©

check: self.noExcludesBetweenAlternativeAndMandatory()

message:

}

'The feature ' + self.source.name + is a Dead Feature'’

constraint noExcludesBetweenMandatoryAndOr {
guard: Link.allInstances.select(l | 1l.son.name = self.source.name).size() > @

self.target.name).size()

and AggregationToFeaturelLink.allInstances.select(l | l.target.name =
>0

check: self.noExcludesBetweenMandatoryAndOr()

message:

}

'The Feature ' + self.target.name + ' is a False Optional Feature’

constraint noExcludesBetweenOrAndMandatory{
guard: AggregationToFeaturelLink.allInstances.select(l | 1.target.name =

self.source.name).size()

> 0
and Link.allInstances.select(l | l.son.name = self.target.name).size() > ©

check: self.noExcludesBetweenOrAndMandatory()

message:

}

context Requires{

'The Feature ' + self.source.name + ' is a False Optional Feature'’

constraint noRequiresAndAlternative{
guard: AggregationToFeaturelLink.allInstances.select(l | 1.target.name =

self.source.name).size()

self.target.name).size()

> 0
and AggregationToFeaturelLink.allInstances.select(l | 1.target.name =
> 0

check: self.noRequiresAlternative()

message:

}

'The Feature ' + self.source.name + ' is a Dead Feature’

constraint noRequiresAndMandatory {
guard: Link.allInstances.select(l | 1l.son.name = self.target.name).size() > @

and Link.allInstances.select(l | 1l.son.name = self.source.name).size() > @

check: self.noRequiresMandatory()

message:

'Mandatory Features being the target of a Requires Dependency whose source

shares the same father is Redundant’

}

constraint noRequiresBetweenMandatoryAndOptional {
guard: Link.allInstances.select(l | 1l.son.name = self.source.name).size() > @

and Link.allInstances.select(l | l.son.name = self.target.name).size() > ©

check: self.noRequiresMandatoryAndOptional()

message:
a false optional feature’

}

'This Requires Dependency makes the non-target Feature (from the same Or node)

constraint onlyOneRequires {
check: Requires.allInstances.select(i | i.target.name = self.target.name).size() =1
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message: 'More than one Requires Dependency is Redundant’

}

constraint noRequiresBetweenMandatoryAndAlternative {
guard: Link.allInstances.select(l | 1l.son.name = self.source.name).size() > @
and AggregationToFeaturelLink.allInstances.select(l | 1l.target.name =
self.target.name).size() > ©
check: self.noRequiresBetweenMandatoryAndAlternative()

message: 'This Requires Dependency makes the non-target Features (from the same
Alternative node) Dead Features'

}

constraint noRequiresBetweenMandatoryAndOptionalAlternative {
guard: Link.allInstances.select(l | 1l.son.name = self.source.name).size() > @
and AggregationToFeaturelLink.allInstances.select(l | l.target.name =
self.target.name).size() > ©
check: self.noRequiresBetweenMandatoryAndOptionalAlternative()

message: 'This Requires Dependency makes ' + self.target.name + ' a false optional
feature'

}

constraint noRequiresBetweenMandatoryAndOr {
guard: Link.allInstances.select(l | 1l.son.name = self.source.name).size() > @
and AggregationToFeaturelLink.allInstances.select(l | l.target.name =
self.target.name).size() > ©
check: self.noRequiresBetweenMandatoryAndOr()

message: 'This Requires Dependency makes ' + self.target.name + ' a false optional
feature'

}
constraint noRequiresBetweenFatherAndSon {
check: Link.allInstances().select(l | l.father.name = self.source.name and l.son.name =

self.target.name).size() = ©

message: 'Father and son features cant be related by a dependency relationship'’

¥
context Alternative {
constraint eachAlternativeHasOnlyOneFatherFeature {

check: FeatureToAggregationLink.allInstances.select(l | l.target = self).size() = 1

message: 'An Alternative Node can only have one Father Feature'

}

context Or {
constraint eachOrHasOnlyOneFatherFeature {
check: FeatureToAggregationLink.allInstances.select(l | 1l.target

1}
[y

self).size()

message: 'An Or Node can only have one Father Feature'
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6. Translating colours - a simple example of model
transformations

As a kind of “Hello World” example of model transformations, let us consider the case of two
trivial visual languages, the one that describes red and green elements, and the one that
describes black and yellow elements. Let's suppose that we want to simply translate the
elements of one to the other as exemplified in the following illustration:

The source metamodel language:

El Origin

8= gmf.diagram

red

green

0. 0

E Red

= name : EString E Green

= name : EString

8= gmf.node . ¢ rod
= gmf.node

The source emfatic file:
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@namespace(uri="Origin", prefix="Origin")
package Origin;

@gmf.node(label = "name",color="255,0,0", figure="ellipse")
class Red {
attr String name;

}

@gmf.diagram
class Origin {
val Red[*] red;
val Green[*] green;

}

@gmf.node(label = "name",color="0,255,0", figure="ellipse")
class Green {
attr String name;

}

The target metamodel language:

H Target

= gmf.diagram

black yellow
0.* 0.*
El Black El Yellow
= name : EString = name : EString
= gmf.node fi= gmf.node

The target emfatic file:

@namespace(uri="Target", prefix="Target")
package Target;

@gmf.diagram

class Target {
val Black[*] black;
val Yellow[*] yellow;

}




@gmf.node(label = "name",color="0,0,0", figure="ellipse")
class Black {
attr String name;

}

@gmf.node(label = "name",color="255,255,0", figure="ellipse")
class Yellow {
attr String name;

}

The model transformations rules (ETL file):

rule Red2Black
transform r: Origin!Red
to b: Target!Black

{
}

b.name=r.name;

rule Green2Yellow

transform g: Origin!Green

to y: Target!Yellow {
y.name=g.name;

}

The target XMl file can be transformed to be edited using the target diagram editor by following
steps:
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